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Creating forms in Microsoft
Access 2007®
This is the fourth document in a series of five on using Microsoft Access 2007®
The aim of this guide is to provide information on using forms in Microsoft Access 2007®
Prior knowledge of how to set up a database in Access® is assumed.
Other documents in the series are:
USER 163
Introduction to Microsoft Access 2007®
USER 164
Creating tables in Microsoft Access 2007®
USER 165
Filters and queries in Microsoft Access 2007®
USER 167
Producing reports in Microsoft Access 2007®

What is a form?
Forms are linked to one or more Microsoft Access® tables and provide an easy to
use interface for accessing, editing and creating records.

Benefits of using a form
·

Consistency and accuracy when adding data

·

An easy to use interface for editing, viewing and entering records

Creating a basic form
·

Select the table that you want to base your form on

·

From the Create tab, click the Form button

Access® will now create a form based upon the selected table. Note that if your
form was based upon the Primary table in a relationship, Access® will create two
forms – the main form for the Primary table and a smaller table for the Child table.
The Child table would be the sub-form.

The Forms Wizard
If you wish to customise the form, the Forms Wizard allows you to select:
·

which fields you require on the form

·

fields from other tables
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·

background colours, styles and different layouts

Creating forms using the Form Wizard
·

From the Create tab, click the More Forms button

·

Select Form Wizard

·

Follow the instructions

Note: choosing the Tabular or Columns style will display the data in table format.
To display the data one record at a time, choose the Columns style

Constructing a form in Design View
If you want to use your own graphical style and layout on a form, you need to
create it in Design View. Design View offers greater flexibility and increased
functionality.
·

Select the table that you want to base your form on

·

From the Create tab, choose the Form Design button

·

A blank form will appear in Design View
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·

To construct the form, select the Design tab

·

Click the Add Existing Fields button

·

A list of field names from the table will appear. Click and drag the fields from
the Field list on to the form area

Experiment with different types and styles of forms. If you are not happy with the
results, you can always delete the form and start again.

Saving a form
·

Right-click on the tab above the form and select Save

·

Enter a name for the form and click OK

·

The name of the form will appear in the All Tables list on the left-hand side
of the screen

Deleting a form
·

Select the form from the All Tables list on the left-hand side

·

Right-click on the name of the form and select Delete

·

You will be asked to confirm if you wish to delete the form, click OK

Viewing records using a form
To navigate through records, use the control panel at the bottom of the form. The
current record number is also displayed in the panel.

Entering data through forms
Any data entered through the form is automatically added and saved to the
appropriate table.
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·

Type the data in the fields provided

·

To move between fields, press the Enter or Tab keys

·

Press Enter when you have completed the form. This sends the record to the
table and the form displays a new blank record

Creating a new record through a form
·

Click the button that has a triangle and a star

·

A new blank record will appear. Complete the appropriate fields

Deleting a record
·

Display the record that you wish to delete

·

From the Home tab, click the Delete button, then choose Delete Record

·

You may be asked to confirm the deletion, if you are sure, click Yes

After you have deleted the records, you are advised to compact the database:
·

Click the Office button

·

Click Manage then choose ‘Compact and Repair Database’

For further information on compacting databases, see the user guide USER 163
Introduction to Microsoft Access 2007®

Filtering data from a form
As with tables, you can filter data from a form. Ensure that you delete any data
from the form that is not to be included in the search.
·

From the Home tab, click the Advanced button, then choose ‘Filter by
Form’

·

Click in the field that you wish to search

·

Click the arrow to the right of the field to reveal a list of data
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·

Select the data you wish to search for

·

At the bottom of the form there is a Look for tab and at least one Or tab.
Look for is the standard option; to set a condition for two or more types of
data, click the Or tab

·

Click the Toggle Filter button to run the filter

·

The filtered records are displayed at the bottom of the form. Use the buttons
on the control panel to view the records retrieved

·

Click the Toggle Filter button again to remove the filter

Subforms – forms within forms
With a relational database (contains one or more related tables) a form can be used
to add data to the related tables. For example, a form used for Award details could
contain a subform to student information.
Subforms are created automatically when you create a form based upon a Primary
table.

Creating subforms using the Forms Wizard
To create subforms using the Forms Wizard, you need to choose an additional table
when the wizard prompts you to choose a table to add fields from. When the wizard
asks how you would like to view form data, there will be a choice of three options:
·

present the data all in one form

·

present it as a subform, which will have two sets of record and navigational
controls

·

use linked forms – the main form will have a button that links to the related
form
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Adding extra functionality to a form
Changing the appearance or adding extra functionality to a form is done within
Design View. Examples of changes that you can make to a form are:
·

adding command buttons, e.g. navigational or Find buttons

·

linking to other forms or tables

·

applying your own colour schemes or using pictures

·

changing the form layout

To modify the appearance of an existing form
·

Open the form

·

Click the View button and select Design View

·

The form will open in Design View. The Design toolbar will appear at the top
of the screen with buttons for modifying the appearance of the form

A basic form has a Detail section which contains the main components of the form,
and a Header and Footer section for holding repeated elements such as text and
graphics. The sections are identified by a blue bar which can be dragged up or
down to provide extra space on the screen.
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Inserting text in Design View

Text can be inserted using the Text Box button.
There are two types of text box – bound and unbound.
·

A bound text box is connected to a field category on a table, e.g. surname

·

An unbound text box is not linked to a field category and can be used to hold
the results of a calculation

To insert a text box

·

Click the Text Box button

·

Move the mouse to the point on the form that you wish to put the text box.
Click and drag to create the text box

·

You can then enter and format text

·

All new text boxes are unbound text boxes. To convert a text box to bound,
see the section Changing a text box from unbound to bound.

Changing the content of a text box
·

Click the text box

·

Move the mouse over the text box and click next to any text that needs to be
edited

·

Edit the text as required

Moving and resizing a text box
·

Select the text box

·

A number of black squares appear on the label with a larger black square in
the top-left corner
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·

Ignore the larger square and drag one of the other squares to move or resize
the text box

Note: if your changes have had an undesired effect, or if you move something
accidentally, click the Undo button

Aligning objects in Design View
·

Hold down the Shift key and click on the objects that you wish to align

·

Right-click and select Align then choose a style of alignment

Form properties
To add extra functionality, form elements such as text boxes have properties.
To view the properties of a text box:
·

Double-click on the text box

or
·

Right-click on the text box and select Properties

The Properties Window will appear on the right of the screen

Any of the properties can be edited, by highlighting the property and entering the
new one.
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Changing a text box from unbound to bound
·

Open the text box properties

·

Click the All tab

·

Click in the space next to Control Source

·

Click the arrow and select a field to attach to the text box

·

Close the Properties window

Using an unbound text box in a calculation
An unbound text box used to display the result of a calculation is called a Calculated
Control. To perform a calculation, your form must contain at least two fields
containing values. The unbound box will contain an expression that uses these
values to perform the calculation.
·

Create an unbound text box and display the properties

·

Click the All tab

·

Click in the space next to Control Source and click the button containing
three dots. The Expression Builder will open – this contains a range of
mathematical functions for developing calculations.

The syntax to perform a simple multiplication would be:
=[name of first value text box]*[name of second value text box]
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For example, if your form contains a text box named ‘quantity’ and the contents are
to be multiplied with those of a text box named ‘price’, the expression would be:
=[Quantity]*[Price]
To test a calculation, switch to Form View

Changing field/text box colour
·

Select the field or text box that you wish to change

·

Click the Fill/Back Colour button

and choose a new colour

To remove a fill colour:
·

Select the field or text box

·

Click the Fill/Back Colour button and choose Transparent

Changing the colour of text
·

Select the field or text box

·

Click the Font Colour button

and choose a new colour

Changing the background colour of a form
·

Click the bar labelled Detail

·

Click the Fill/Back Colour button

and choose a new colour

Using properties to enhance a form
Like text boxes, the form has its own set of properties that can change the
appearance.
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To open the properties of a form:
In the top-left of the form window, where the two rulers meet, is a blue box. The
box may also contain a small black square.

Double-click the box to open the properties of the form.

Setting the form properties to use a background image
Note: you are advised to use GIF or JPEG images as these have relatively small file
sizes. To create a patterned background, set the Picture Tiling property.
·

Display the Form properties

·

From the tabs across the top of the box, click the All tab

·

Scroll down the list of properties and select the Picture property

·

Click the button containing 3 dots

·

From the window that appears, locate and select an image

·

Click OK

To remove a picture background from a form
·

Display the Form properties

·

Locate the Picture property and delete the file associated with it

Applying headers and footers to a form
Headers and footers are useful places to put text, logos and command buttons, e.g.
add/delete record.
Placing objects inside the header or footer will place them at the top or bottom of a
form.
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·

Right-click on the form

·

Choose Form Header/Footer

·

The appropriate header and footer will be added to the form. You may need
to resize the form window

To change the size allocated to your header or footer:
·

Position the mouse over the Detail bar to change the height of the header, or
over the Footer bar to change the footer

·

When the pointer changes to the black ‘up and downward’ arrow, hold down
the mouse button and drag the bar

Command buttons
A Command button is an object on a form that represents a shortcut to a menu
option. Command buttons are commonly used for inserting and deleting records
from a form. You could also use the form as an introductory page, with Command
buttons linked to all forms within the database.
Adding a Command button in Design View
·

Ensure that the Use Control Wizards button is selected

·

Click Button on the toolbar

·

Click the point on the form where you wish to insert the Command button

·

The Command Button Wizard will open. Follow the instructions to assign an
action that will occur when the Command button is selected

Displaying a form on Startup
To display a form when the database is opened, instead of the Database window:

·

Click the Office button

·

Click the Access Options button
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·

Select Current Database

·

Click the arrow next to Display Form

·

Select the form that you wish to display on Startup

·

Click OK

Where next
Once you have learned how to create and customise a database, the next step is to
generate printed information from the database for analysis. For further details of
how to do this, see USER 167 Producing reports from Microsoft Access 2007®

Where to go for more help or information
You can get further help from the Information Services Help Desks at:
Thompson Library: 01782 294771
Brindley IT Centre: 01782 294135
Octagon IT Centre: 01785 353339
Online:
Email:

www.staffs.ac.uk/ishelp
libraryhelpdesk@staffs.ac.uk

(for all IT and Library queries)

All Microsoft ® product screenshots and references are used by permission of
the Microsoft® Corporation. Windows® operating system

14

